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1. Introduction

This document describes how to use the templates that have been made to help you format your text in Word for Windows version 97 or 2000 (collectively referred to as “the KAP templates”).

Two sets of templates are provided: 

· To format your document over 1 column, you should use one of the following templates: vbaKAPedvo.dot (for a contribution to an edited volume), vbaKAPmono.dot (for a monograph) or vbaKAPproc.dot (for a contribution to Proceedings volume). 

· To format your document over 2 columns, you should use one of the following templates: vbaKAP2edvo.dot (for a contribution to an edited volume), vbaKAP2mono.dot (for a monograph) or vbaKAP2proc.dot (for a contribution to Proceedings volume). 

Note that you should never edit any of these template files directly.
The templates have been built for Word97 and Word2000. They will work regardless of the language version of Word that you are using. They will not work, however, with earlier versions of Word.

1.1 Availability of the templates

In order to use the templates, you must place them in any of the directories in which Word looks for templates. Which directories these are, is defined from within Word under Tools/Options/File Locations. (See the example below.)
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1.2 Contents of the templates

1.2.1 Macros

A macro is a small computer program that works only within the environment provided by another much more comprehensive computer program (in this case, Microsoft Word version 97 or 2000). Microsoft Word macros are written in Word’s internal programming language, called Visual Basic for Applications (VBA), and are stored in a Word template.

The KAP templates contain a number of macros, written to help you make your document conform to the KAP guidelines quickly and easily. These macros are all described in the document you are now reading.

Although all macros were thoroughly tested in different environments, there is always the possibility that your document has been changed in such a way that a macro fails to work as expected. In the case of a macro failing, please read the error message that is displayed. If you cannot figure out what went wrong, save and exit your document, open a new document based on the KAP templates and copy your work into this new document before running the macro again.

Many macros display dialog boxes to ask for your input. If you cannot see all the text that is pre-displayed in any text input box in a dialog box, try placing the cursor inside the text and scrolling using the cursor keys.

1.2.2 KAP menu and toolbar

All macros contained in the KAP templates may be accessed from either a menu or a toolbar, as follows:

· A KAP menu has been added to the menu bar, containing options for all the macros. Tool Tips and keyboard shortcuts are provided. The menu is always present.

· A KAP toolbar has been added, containing options for all the macros. Tool Tips are provided. The toolbar may be enabled and disabled using View/Toolbars.

1.2.3 Styles

The KAP templates contain all the styles that you need for formatting your documents. If you are not familiar with the way Word uses styles, please refer to the documentation that came with Word for an introduction to styles.
All styles are available at all times. However, some styles are present only because Word and/or any of the macros rely on them. The following is an overview of those styles, that you should never use in the body of your document:
1.2.3.1 Styles that you need never use

	Name
	Used for

	capLabel
	The label of a table or figure. This style is applied when you use the Insert Table or Insert Figure macro.

	Caption
	The caption of a table or figure. This style is applied when you use the Insert Table or Insert Figure macro, or when you should use the Insert/Caption option (for which, however, there is no need).

	CN
	The word “Chapter” preceding the chapter number.

	Endnote Reference
	The reference to an automatic endnote. Please note that you should use the Insert/Endnote option only if you wish to use Microsoft’s Endnotes Wizard, and then only to generate your bibliographic reference which is then pasted into the text.

	Endnote Text
	The text of an automatic endnote. See note on Endnote Reference.

	Footer
	The running footer texts. 

	Footnote Reference
	The reference to an automatic endnote.

	Footnote Text
	The text of an automatic footnote.

	Header
	The running header texts. This style is applied when you use the Edit Headers macro.

	Heading 5
	A Heading 5, which is not part of the KAP guidelines.

	Heading 6
	A Heading 6, which is not part of the KAP guidelines.

	Heading 7
	A Heading 7, which is not part of the KAP guidelines.

	Heading 8
	A Heading 8, which is not part of the KAP guidelines.

	Heading 9
	A Heading 9, which is not part of the KAP guidelines.

	Macro Text
	The text of a macro when opened into a macro editing window.

	Table
	A table that is inserted with the Insert Table macro.


In addition, there are five styles that should be used only for a very specific purpose. These are described below, on page 8.

2. Creating a new document

Please note that to convert an existing document, you should first create a new document based on one of the KAP templates, and then insert or copy your existing document into this.

To create a new KAP document, do the following:

1. From within Word, choose File/New.

2. From the overview of templates that is displayed, select the appropriate template:

· vbaKAPedvo.dot (to produce a contribution to an edited volume laid out over 1 column); or
· vbaKAPmono.dot (to produce a monograph laid out over 1 column); or 

· vbaKAPproc.dot (to produce a contribution to a Proceedings volume laid out over 1 column); or
· vbaKAP2edvo.dot (to produce a contribution to an edited volume laid out over 2 columns); or
· vbaKAP2mono.dot (to produce a monograph laid out over 2 columns); or 

· vbaKAP2proc.dot (to produce a contribution to a Proceedings volume laid out over 2 columns). 

Note that the .dot extension may not be visible; this is dependent on your user preferences regarding the display of file extensions. 

3. A macro starts, prompting you for a number of document details (see page 9). Enter the required details, then click OK.

4. Position the cursor at the end of the document (for example, by pressing <Control-End>) to start working.

If you are editing a 2-column document, using the appropriate templates, the columns will only be laid out side by side on the screen if you are working in Page/Print Layout View. In Normal View, only one long column will be visible; this does not, however, affect the contents of your document. For more information, refer to Word’s on-line Help.

3. Formatting your document as you work

As has been said before, the KAP templates contain all the styles that you need for formatting your documents. 

It is extremely important that you use styles as much as possible to format your text. Apply direct formatting only when the style does for some reason not meet your needs. Also, do not use any style for a purpose other than that for which it was intended (refer to the tables below for more information).
In addition to the styles, macros have been provided for inserting a figure with its caption (Insert Figure) and for inserting a table with its caption (Insert Table). 

Word has a number of automatic formatting features built in under the name AutoFormat. Please note that using the AutoFormat from the Format menu will almost certainly result in formatting that is not compatible with the KAP guidelines. You are most strongly advised never to use this feature on a KAP document. 

AutoFormatting may also be set to take place automatically, as you work. Again, this is a highly undesirable situation, and you must disable this feature when working on a KAP document.

To ensure that no auto-formatting takes place during your work, choose Tools/AutoCorrect, then click on the AutoFormat As You Type tab to display the following dialog box:
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Three blocks of options are present, where you should set checkmarks as follows:

· Under Apply As You Type, none of the options should be checked;

· Under Replace As You Type, any of the first 5 options may be set should you find them useful. However, the final option in this block, Internet and network paths with hyperlinks must not be checked;

· Under Automatically As You Type, again none of the options should be checked.

Please ensure that the AutoFormat As You Type options are set as described here before you start working on any KAP document. Be aware that these settings are not associated with a particular document or template, and carry over from one Word session to the next.

3.1 Inserting the document details

When you create a new KAP document, the first page of the new document shows a table containing placeholders for the so-called document details: Chapter Number, Title, Subtitle, Author, and Affiliation. Each of these is styled as described in the table below. A macro will start automatically, prompting you for changes; you may enter the real details into the dialog box that is displayed, or you may click Cancel and change the details directly in the document immediately or at a later time.

3.1.1 Styles for the document details

	Name
	Use
	Status

	ChapterNo
	Use for the chapter number, if any, of your document only. Place the chapter number in the top right table row and ensure it is formatted with the ChapterNo style.
	The chapter number must always be entered in a Monograph or a in an Edited Volume chapter. No chapter number may be entered in a Proceedings chapter.

	Title
	Use for the title of your document only. Place the title in the second table row and ensure it is formatted with the Title style.
	The title must always be entered.

	Subtitle
	Use for the subtitle, if any, of your document only. Place the subtitle in the third table row and ensure it is formatted with the Subtitle style.
	The subtitle is always optional: it may or may not be entered.

	Author
	Use for the author(s) of your document only. Place the author(s) in the fourth table row and ensure the text is formatted with the Author style.
	The author(s) must always be entered in an Edited Volume or Proceedings chapter. No author(s) may be entered in a Monograph.

	Affiliation
	Use for the affiliation(s) of the author(s) only. Place the affiliation(s) in the fifth table row and ensure the text is formatted with the Affiliation style.
	The affiliation(s) must always be entered in an Edited Volume or Proceedings chapter. No affiliation(s) may be entered in a Monograph.


These styles were defined for the stated purpose only. They are vital to the working of the Document Details and Edit Headers macros (see below), as well as to a proper functioning of the template with which later the Table of Contents and the Index will be produced.

You should not use any of these styles outside the document details table on the first page of your document. Neither should you use any of them in the wrong place in the table, or more than once.

Note:
In the case of multiple authors, separate the names with commas and precede the last author with the word and. In the case of multiple affiliations, separate the names with colons. If multiple authors are affiliated with one affiliation, or vice versa, then you should use superscripted numerals to identify the connections.

3.1.2 The Document Details macro

The macro that prompts you for the so-called document details (chapter number, title, subtitle, author(s), and affiliation(s)) is called AutoNew. This is a reserved name, which causes Word to run the macro whenever a new document is created. However, on the KAP menu and toolbar this macro is called Document Details.

The default values for each of the document details as shown in the dialog box are based on the first paragraph in your document that is styled with the corresponding style. Note that each of the document details is defined as “mandatory”, “optional” or “prohibited”, as follows:

	
	Monograph
	Edited Volume chapter
	Proceedings chapter

	Chapter number
	mandatory
	mandatory
	prohibited

	Title
	mandatory
	mandatory
	mandatory

	Subtitle
	optional
	optional
	optional

	Author(s)
	prohibited
	mandatory
	mandatory

	Affiliation(s)
	prohibited
	mandatory
	mandatory


In using the Document Details macro, note the following:

· the macro will run only if all the “mandatory” elements that are defined for the document type are present and formatted with the corresponding style; and these mandatory elements cannot be deleted using the macro.

· if a “prohibited” element is present before the macro runs, this will be deleted from your document on exiting the macro.

To change document details after a new document has been created, you may either re-run the macro from the KAP menu or toolbar, or you may simply edit the document directly. 

Note: do not change the styles in the table on the first page, not even if the corresponding table row contains no text.

3.2 Body text and headings

A number of styles has been defined for body text and headings. Note that you need not press <Return> to insert a blank line, and neither need you type a number in front of a heading, as all line spacing and most other formatting is handled by the styles.

3.2.1 Styles for body text and headings

The following styles have been defined for running text and headings:

	Name
	Use

	Normal
	Use for body text. Keyboard shortcut: Shift+Control+5 (on the numeric keypad, when NumLock is Off).

	Heading 1
	Use for top-level headings. Do not type a heading number.

	Heading 2
	Use for second-level headings. Do not type a heading number.

	Heading 3
	Use for third-level headings. Do not type a heading number.

	Heading 4
	Use for lower-level headings. Do not type a heading number and end with a full stop.

	HeadingMath
	Use for Mathematical Headings.


3.3 Inserting lists, tables and figures

This section describes how to insert a list, a table or a figure into your document so that the KAP guidelines are automatically applied.

3.3.1 Styles for lists and tables

	Name
	Use

	LISTalp
	Use for alphabetically ordered lists.

	LISTdash
	Use for unnumbered lists.

	LISTnum
	Use for numerically ordered lists.

	small
	Use for table notes.


3.3.2 Inserting a list

For inserting a list into your document, no macro is needed. Simply format your list items with the appropriate style: 

LISTalp for the following format:

a) Lorum ipsum dolor sit amet, veniami quis nostrud laboris aliquip ex ea com dolor in rep derit in voluptate nonumy. Min veniami quis nostrud laboris nisi ut aliquip ex ea com do minimim veniami quis nostrud laboris nisi ut aliquip ex ea com.

LISTnum for the following format:

1. Min veniami quis nostrud laboris nisi ut aliquip ex ea com do minimim veniami quis nostrud laboris nisi ut aliquip ex ea com. Lorum ipsum dolor sit amet, veniami quis nostrud laboris aliquip ex ea com dolor in rep derit in voluptate nonumy. Min veniami quis nostrud laboris nisi ut aliquip ex ea com do minimim veniami quis nostrud laboris nisi ut aliquip ex ea com. 

and LISTdash for the following format:

· Min veniami quis nostrud laboris nisi ut aliquip ex ea com do minimim veniami quis nostrud laboris nisi ut aliquip ex ea com. In veniami quis nostrud laboris nisi ut aliquip ex ea com do minimim veniami.

3.3.3 Inserting a table: the Insert Table macro

To insert a table into your document, do not use the built-in Word function Table/Insert Table. Instead, run the Insert Table macro from the KAP menu or toolbar. This macro will display the following dialog box:
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Enter the desired number of columns and rows for your new table. Note that you can very easily insert more rows later, simply by pressing <TAB> in the last table cell—you may wish to leave the number of rows at the default value of 2. You must also provide a caption, so that the macro can format this in accordance with the KAP guidelines. However, at this point you may wish to not modify the default caption provided, as you can always modify it directly in your document.

When you click OK, an empty table is inserted before the current paragraph. Note that the macro will not allow you to insert a table inside an existing table.

In case of a full-width table in a two-column document, the macro creates a frame around the table and inserts an additional  blank line below the last row. Make sure to leave this line empty and start typing below the frame.

Table notes should be formatted using the Small style.

3.3.4 Inserting a figure: the Insert Figure macro

To insert a new figure into your document, do not use Insert/Picture or any other option from the Insert menu. Instead, run the Insert Figure macro from the KAP menu or toolbar. This macro will display the following dialog box:
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Enter a caption, so that the macro can format this in accordance with the KAP guidelines. However, at this point you may wish to not modify the default caption provided, as you can always modify it directly in your document.

When you click OK, an empty figure (placeholder) is inserted before the current paragraph.

To include the figure that you need, you may now (or at any later time) left-click once on the placeholder that was inserted by the macro and then use the standard Insert/Picture/From File option provided by Word. Alternatively, you can Paste a figure that you have previously Copied to the Windows Clipboard.

Note that the figure caption is centred. If your caption is more than one line long, you should click in it, then set the paragraph alignment to Left yourself (either by using the Format/Paragraph option or by clicking the corresponding icon on the Formatting toolbar).

3.4 Inserting special text elements

The following describes how to insert elements that are not document details, body text, headings, lists, tables or figures.

3.4.1 Styles for special text elements

	Name
	Use

	Abstract
	Use for the Key Words and the Abstract.

	Appendix
	Use for the text of the Appendix.

	BlockQuote
	Use for the text of a block quote.

	Equation
	Use for an equation.

	HeadingOther
	Use for the heading of the Acknowledgements, the Appendix, the Notes and the References.

	Motto
	Use for the text of a motto for your document.

	Notes
	Use for the text of the Notes.

	References
	Use for the text of the References.


3.4.2 Inserting the Key Words or the Abstract

Any new Edited Volume or Proceedings chapter that you create will already contain placeholders for the Abstract and Key Words sections. These headings are styled with Abstract. 

· Enter the Abstract following the Abstract heading.

· Enter the Key Words following the Key Words heading;

The label (“Key words” or “Abstract”) should be separated from the text that you enter with one tab character (already present in the template). To start another paragraph within a Key Words or Abstract section, press <Return> followed by <TAB>.

A Monograph document does not by default contain placeholders for the Key Words and Abstract sections. You may however enter these yourself, styled with Abstract.

The Key Words and/or Abstract sections may at any time be removed if you do not need them.

3.4.3 Inserting a block quote or an equation

Styles are provided for block quotes and equations, as follows:

· Style a block quote with BlockQuote;

· Style an equation with Equation. After you have entered the equation, press <TAB> and enter the sequence number in parentheses. (If the Microsoft Equation Editor is installed, you may use this program by choosing first Object and then Microsoft Equation from the Insert menu.)

3.4.4 Inserting a footnote

A footnote is inserted using Insert Footnote. Styling is handled automatically.

3.4.5 Inserting the Acknowledgements, the Appendix, the Notes or the References

These elements are all handled with styles, as follows:

· the headings of the Acknowledgements, Appendix, Notes and References sections should all be styled with HeadingOther (no heading numbers will be included);

· the Acknowledgements text should be styled as Normal text;

· the Notes text should be styled with Notes (do not build the Notes section using the Word function Insert/Endnote!);

· the Appendix text should be styled with Appendix;

· the References text should be styled with References.

4. Re-formatting an existing document

Often you may wish to apply the KAP guidelines to an existing Word document, or even to a document that was produced using a word processor other than Word.

To “convert” an existing document to the KAP guidelines, do the following:

1. Open the document in Word. Note that if the file extension is anything other than .DOC, you may have to change the setting of the file type in the Open dialog box, as by default Word only lists files with the extension .DOC.

2. Before you do anything else, use File/SaveAs to save the file under a different name. When doing so, ensure that the file type for the newly-saved file is set to “Word documents” and that the new file will be given the file extension .DOC. You have now created an intermediary working document: Any changes that you make will leave the original file untouched.

3. Choose Tools/Templates and Add-ins and attach the appropriate KAP template to the document. Ensure that the box labelled Automatically Update Document Styles is checked, as follows:
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Next, click OK.

4. Choose Edit/SelectAll, then apply the Normal style to all selected text (i.e., the whole document).

5. Save the document at this stage.

6. Place the cursor at the top of the document (for example, by pressing <Control-Home>, and perform a general search-and-replace as follows:
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Use the Replace All button to make the replacement, and repeat this action until the following message appears, indicating that the search string was not found:
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7. Now work your way down through the document, applying styles to the text. Use the same styles that you would have applied if you had originally written the document using a KAP template.

8. Finally, create a new document based on the appropriate KAP template. After filling in the document details as prompted, copy all of the text in the working document and paste it into the new document that contains the document details. After you have saved this final document, you may delete the working document from your hard disk.

5. Formatting your document before printing

Before you print your document, you may wish to add some finishing touches with regard to the KAP guidelines. Two macros are provided, one (Edit Headers) to help you set the text in the running headers, the other (Prepare Copy) to remove any excess of white space caused by having multiple headings following one another and to set the Key words and Abstract labels to bold.

In addition to using these macros, there are three more things you should pay attention to:

· Choose Tools/Options/Compatibility and ensure that the two options to suppress additional line spacing at the top of a page are checked, as follows:
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· Do not use Format/AutoFormat. 

· Do not change the margins or the paper size manually but use the Paper Size macro to set the page layout for printing on A4 or US Letter size paper.

5.1 Fixed positioning of text or graphics

Word allows you to place what it calls a “frame” around a figure, a table, or any other element of your document so that its position on the page is fixed. To learn how to use this Word functionality to achieve the desired result, look up the various entries under Frames in the on-line Help.

5.2 The Edit Headers macro

To specify the texts that must be printed on the left-hand pages and the right-hand pages of the document, run the Edit Headers macro from the KAP menu or toolbar. 
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Initially, the default values for each of the headers as shown in the dialog box are based on your document details; subsequently, they are based on what was already present in the headers. You may need to edit either ot both of the headers in accordance with the KAP guidelines.

Note that the macro will work only if your document contains at least three pages. 

5.3 The Prepare Copy macro

Before you deliver the final document, run the Prepare Copy macro from the KAP menu or toolbar. This macro performs the following tasks:

· it sets the Key words and Abstract labels to bold;

· it removes any excess whitespace caused by the absence of a Subtitle;

· it removes any excess whitespace caused by having multiple headings following one another.

This is the only macro that does not display a dialog box. Execution of the macro may take some time, depending on the amount of memory in your PC.

5.4 The Paper Size macro

All documents based on the KAP templates use a page layout of 16 by 24 centimetres. This custom page layout can be printed on A4 or US Letter size paper, depending on which paper is used in your printer.
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By default, the paper size is set to A4. The Paper Size macro lets you change this to US Letter or, if you have already done so, back to A4. Note that the macro also adjusts the various margins so that the page layout does not change when you change the paper size. For this reason, you should never change the paper size manually but always use the macro.
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